
Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

A 
Rok 

18.3.2003 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 
GRA GEO UNI VSŠ VKI 

Poskus: 

 
1. (20) f1 je gorišče elipse, AB pa ena od njenih glavnih osi. Nariši 
manjkajočo glavno os CD in gorišči F.  

2. (20) Poišči točko T, ki leži na premici P in je kar se da blizu točki 
S.  

3. (40) Koliko dolg je tisti del prve padnice ravnine, ki gre skozi 
točko A in leži v prvem kvadrantu. Označi ga z l0.   

 



 
4. (10) Izračunaj dimenzije formata A2.  

5. (10) Kaj veš o kotirnih mejah? Skica!  

6. (10) Skiciraj in imenuj možne lege telesa pred koordinatno ravnino.  

7. (10) Naštej in s skico pojasni vrste projekcij glede na merila koordinatnih osi?  

8. (10) Definiraj in skico pojasni, kaj je soslednica?  

9. (10) Kaj je značilno za rastersko zapisane slike?  

10. (10) Naštej in kratko opiši vrste programov za risanje.  

11.(10) Od kod ime »ploskovni model«?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

18.3.2003 B 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime, vpisna številka: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (15) Nariši pravilni osem-kotnik, ki ima za stranico daljico AB. 2. (25) Poišči manjkajoči ris točke T, ki leži na ravnini, ki je podana 

s premicama p in r.  

3. (40) Izračunaj, koliko je v resnici velik trikotnik ABC, ki leži na 
ravnini ε.  

 



 
4. (10) Izračunaj dimenzije formata A2.  

5. (10) Kaj veš o zlatem rezu 

6. (10) Skiciraj kocko v standardni izometrični projekciji in označi bistvene značilnosti projekcije.  

7. (10) V čem je razlika med bočnim in stranskim risom. Pojasni s skico.  

8. (10) Čemu je namenjena podatkovna rokavica?  

9. (10) Naštej in pojasni dva glavna načina za računalniški zapis slik.  

10. (10) Kaj je značilno za slikarske programe?  

11.(10) Kaj so v CAD programih plasti?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

6.5.2003 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (15) Nariši krožni lok z radijem r=5 cm od točke T do premice p 
tako, da bo lok pravokoten na premico p.  

2. (25) Poišči manjkajoči ris točke T, ki leži na ravnini, ki je podana 
s premicama p in r.  

3. (40) Izračunaj površino kroga, ki nastane kot presek ravnine in 
krogle, ki ima središče v točki T in gre skozi točko A, ki leži na 
ravnini.Pomagaj si z bočnim risom. 

 



4. (10) Če je črka H velika 5 mm, kako velika naj bi bila črka a in kolikšen naj bi bil razmak med vrsticami. Skica! 

5. (10) Kaj veš o kotirnih mejah? Skice! 

6. (10) Skiciraj kocko v standardni izometrični projekciji in označi bistvene značilnosti projekcije.  

7. (10) Kaj ja padnica. Pojasni s skico.  

8. (10) Katere so tehnične značilnosti rasterskih zaslonov? 

9. (10) Naštej in pojasni dva glavna načina za računalniški zapis slik.  

10. (10) Kaj je značilno za slikarske programe?  

11.(10) Kaj so v CAD programih plasti?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

1.7.2003 (A) 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (20) Približno nariši elipso, ki ima AB=7cm in CD=4cm. 2. (20) Nariši daljico med točkama A in B, ki ležita na ravnini. 

3. Ugotovi pravo velikost kota med premicama pri točki A. Določi 
lego točke C, tako da bo trikotnik ABC enakokrak. 

 



A 
4. (10) Kdaj so se pojavile prve gradbeniške risbe, kako je to vplivalo na gradnje. 

5. (10) Kako je določena velikost formata A0. Skica! 

6. (10) Skiciraj kocko v poševni, izometrični projekciji in opiši bistvene značilnosti te projekcije.  

7. (10) Definiraj, kaj je padnica! Skica!  

8. (10) Naštej in kratko opiši vrste programov za risanje. 

9. (10) Kaj je »ločljivost« rasterske slike; kako vpliva na kvaliteto slike?  

10. (10) Kaj pomeni kratica CAD?  

11.(10) Kaj so v CAD programih bloki?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

1.7.2003 (B) 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (20) Nariši pravilni osem-kotnik, ki ima za stranico daljico AB. 2. (20) Nariši daljico med točkama C in D, ki ležita na ravnini.  

3. (40) V točki A je luč. Nariši senco piramide ABCD na ravnini, 
ki jo določata slednici e1 in e2. 

 



B 
4. (10) Izračunaj dimenzije formata B0.  

5. (10) Kaj veš o kotirnih mejah? Skice! 

6. (10) Skiciraj kocko v standardni izometrični projekciji in označi bistvene značilnosti projekcije.  

7. (10) V čem je razlika med bočnim risom in zvračanjem ravnine okrog slednice. Pojasni s skicama.  

8. (10) Naštej kak primer uporabe računalniškega vida. 

9. (10) Naštej in pojasni dva glavna načina za računalniški zapis slik.  

10. (10) Kaj je značilno za slikarske programe?  

11.(10) Kaj so v CAD programih plasti? 

 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

A 
Rok 

2.9.2003 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 

GRA GEO UNI VSŠ 

Poskus: 

1.  2.  3.  4.  5.  6. 

 
1. (20) Konstruiraj premico, ki je tangenta na podani krožnici. 2. (20) Konstruiraj prebodišče premice p z ravnino ε    

3. (40) Izračunaj površino trikotnika ABC.    



 
4. (10) V čem je razlika med projektom, risbo in načrtom?  

5. (10) Od česa je odvisna dolžina kotirne puščice?  

6. (10) Naštej in s skico pojasni vrste projekcij glede na lego telesa pred projekcijsko ravnino?  

7. (10) Definiraj in skico pojasni, kaj je koincidenčna premica?  

8. (10) Kadaj bi uporabil "slikarski" program za risanje?  

9. (10) Opiši, kako deluje postopek "sledenje žarku" (ray tracing). 

10. (10) Kaj naredi ukaz STRETCH v AutoCADu?  

11.(10) Od kod ime »volumski model«?  

 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

B 
Rok 

4.9.2001 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 

GRA GEO UNI VSŠ 

Poskus: 

 
1. (20) Nariši ločno prehodnico med podanima krogama. Najprej 
poišči njuni središči.  

2. (20) Konstruiraj prebodišče premice p z ravnino ε.. 

3. (40) Na podani ravnini naj leži premica p. Poteka naj skozi 
točki A in B. Kakšen kot oklepa s Π1.   

 



 
4. (10) Kaj je to "vložni načrt"?  

5. (10) Kaj veš o vrstah črt v tehničnih risbah?  

6. (10) Naštej in s skico pojasni vrste projekcij glede na merilo?  

7. (10) Definiraj in skico pojasni, kaj je padnica?  

8. (10) V čem so prednosti in slabosti zaslonov iz tekočih kristalov? 

9. (10) Kdaj bi uporabil "ilustratorski" program za risanje? 

10. (10) Kaj je "model space" v AutoCADu?  

11.(10) Od kod ime »ploskovni model«?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

16.9.2003 (A) 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (20) Približno konstruiraj elipso, ki ima gorišči f1 in f2 in gre 
skozi točko T. 

2. (20) Nariši tloris in naris pokončnega stožca, ki ima vrh v točki 
A, točka T pa je ena od točk na plašču. Stožec stoji na tlorisni 
ravnini. 

3. Na ravnini ε  konstruiraj kvadrat, ki ima za stranico daljico AB. 
Kvadrat naj v celoti leži v prvem kvadrantu. 

 



 
4. (10) Kaj je zlati rez? Skica! 

5. (10) Kako je določena velikost formata A0.  

6. (10) Skiciraj kocko v poševni, dimetrični projekciji in označi bistvene značilnosti te projekcije.  

7. (10) Definiraj, kaj je padnica! Skica!  

8. (10) Pojasni razliko med risalniki in tiskaniki.  

9. (10) Kaj je »ločljivost« rasterske slike; kako vpliva na kvaliteto slike?  

10. (10) Naštej in opiši postopke za senčenje?  

11.(10) Kaj so v CAD programih bloki?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

16.9.2003 (B) 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (20) Konstruiraj pravilni osem-kotnik, ki ima središče v točki A 
in en vogal v točki B. 

2. (20) Skozi točko T,  ki leži na ravnini, in ki je podana s 
premicama p in r, nariši premico q, ki vzporedna s koincidenčno in 
s tlorisno ravnino (in ne leži nujno v ravnini). 

3. (40) Izračunaj, koliko je v resnici velik trikotnik, ki ga omejujeta 
slednici podane ravnine in prva padnica skozi točko T.  

 



 
4. (10) Izračunaj dimenzije formata A2.  

5. (10) Kaj veš o kotirnih mejah? Skice! 

6. (10) Skiciraj kocko v standardni izometrični projekciji in označi bistvene značilnosti projekcije.  

7. (10) V čem je razlika med bočnim in stranskim risom. Pojasni s skico.  

8. (10) Čemu je namenjena podatkovna rokavica?  

9. (10) Naštej in pojasni dva glavna načina za računalniški zapis slik.  

10. (10) Opiši načine za stiskanje rastrskih slik!  

11.(10) Kaj so v CAD programih plasti?  

 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: Rok 

21.10.2003 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 

GRA GEO UNI VSŠ 

Poskus: 

 
1. (20) Nariši krožni lok, ki mu je premica p tangenta in ki gre 
skozi točko T. 

2. (20) Podano je nekaj točk. Z A označi tisto, ki je najvišje, z B 
tisto, ki je najbližja opazovalcu, C naj bo  najbližje narisni ravnini, 
z D tisto, ki je najbližje koincidenčni ravnini in z E tisto, ki je 
nabližje točki Z. 

3. (40) Poišči tloris in naris točke D, ki leži simetrično A glede na 
premico, ki jo določata točki A in B. Pomoč: Poišči ravnino, ki jo 
določajo točke A,B,C, zvrni jo v tlorisno … 

 



 
4. (10) Izračunaj velikost formata B5. Zadostujejo pravilno nastavljene formule.  

5. (10) Treba je zložiti risbo veliko 80*60 cm. S skico pojasni, kje bi bile gube.  

6. (10) Skiciraj kocko poljubnem vojaškem risu.  

7. (10) Naštej in skiciraj vrste projekcij glede na lego predmeta pred projekcijsko ravnino.  

8. (10) Naštej nekaj grafičnih vhodnih naprav in jih razvrsti glede na to, koliko informacij / sekundo lahko privedejo v računalnik – od 
najpočasnejših do najhitrejših.  

9. (10) Kako so v računalniku predstavljene barve?  

10. (10) Naštej vrste programov za risanje in opiši razlike med njimi. 

11.(10) Kaj naredi ukaz ERASE v AutoCADu?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

14.1.2004 (izredni) 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: VSŠ Poskus: 

 
1. (20) Približno nariši elipso, ki ima AB=7cm in CD=4cm. 2. (20) Nariši slednici ravnine, ki je podana s soslednicama 

(izohipsama) a in b. 

3. Ugotovi pravo velikost kota med premicama pri točki A. Določi 
lego točke C, tako da bo trikotnik ABC enakokrak. 

 



A 
4. (10) Kdaj so se pojavile prve gradbeniške risbe, kako je to vplivalo na gradnje. 

5. (10) Kako je določena velikost formata A0. Skica, formukle! 

6. (10) Skiciraj pravokotno mizo v vojaškem risu. 

7. (10) Definiraj, kaj je padnica! Skica!  

8. (10) Naštej in kratko opiši vrste programov za risanje. 

9. (10) Kaj je »ločljivost« rasterske slike; kako vpliva na kvaliteto slike?  

10. (10) Kaj pomeni kratica CAD?  

11.(10) Kaj so v CAD programih bloki?  

 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

A 
Rok 

17.2.2004 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 
GRA GEO UNI VSŠ VKI 

Poskus: 

Rezultati bodo objavljeni v petek zjutraj, dvig vaj in vpis ocen bo v ponedeljek, 20.3. 12:00-12:30, zagovori pa 12:30-13:00. 
1. (20) Nariši ločno prehodnico z r=3cm med premico in krožnico. 
Označi začetno in končno točko.  

2. (20) Določi vidnost premic p in q tako, da del v prvem kvadrantu 
narišeš debelo in skrito premico prekineš. 

3. (40) Pokončen valj stoji na ravnini Π1, os gre skozi točko T, 
radij pa je 2cm. Odrežemo ga z ravnino ε. Nariši telo (tloris in 
naris), ki pri tem nastane.  

 



 
4. (10) Kaj veš o DIN formatih papirja.  

5. (10) Skiciraj odnos med informacijskimi in materialnimi procesi v tehniki? 

6. (10) Od česa je odvisna debelina najdebelejše črte v tehničnih risbah?  

7. (10) Naštej in s skico pojasni vrste projekcij glede na lego telesa glede na projekcijsko ravnino?  

8. (10) Definiraj in skico pojasni, kaj je soslednica?  

9. (10 ) V čem je bistvena razlika med programi za tehnično risanje in programi za načrtovanje?  

10. (10) Kaj naredi ukaz EXTEND v AutoCADu?  

11.(10) Kako so lahko v računalnikih predstavljena telesa? Skica vseh treh načinov!  

 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

B 
Rok 

17.2.2004 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 

GRA GEO UNI VSŠ 

Poskus: 

 
1. (20) Poišči natančno lego za 8 točk elipse, ki je podana s točko 
in gorišči f1 in f2. 

2. (20) Nariši slednice ravnine, ki je določena s premico in točko.   

3. (40) Premici p nariši tisto vzporednico r, ki je od nje oddaljena 
natanko 2 cm 

 



 
4. (10) Po širini razdeli pravokotnik, v katerem je to besedilo, po zlatem rezu. Naj te ne moti, če konstrukcije sega v druga vprašanja.  

5. (10) Kako je določena velikost tehnične pisave. Kako veliki naj bi bila znaka “H” in “a”  v ISO A pisavi, ki je pisana s pisalom 
debeline 0.7 mm. 

6. (10) Naštej in s skico pojasni vrste projekcij glede na osnovne elemente. 

7. (10) Definiraj in skico pojasni, kaj je padnica. 

8. (10) Kaj je značilno za vektorsko/objektno zapisane slike?  

9. (10) Kaj je značilno za 4D CAD programe?  

10. (10) Kaj naredi ukaz TRIM v AutoCADu?  

11.(10) Od kod ime »ploskovni model«? Pojasni s skico.  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

4.5.2004 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (15) Nariši krožni lok z radijem r=5 cm od točke T do premice p 
tako, da bo lok pravokoten na premico p.  

2. (25) Poišči manjkajoči ris točke T, ki leži na ravnini, ki je podana 
s premicama p in r.  

3. (40) Izračunaj površino kroga, ki nastane kot presek ravnine in 
krogle, ki ima središče v točki T in gre skozi točko A, ki leži na 
ravnini.Pomagaj si z bočnim risom. Nariši (15) toloris in naris 
krogle – prava velikost radia krogle?, (10) bočni ris krogle in 
ravnine, (5) presek krogle in ravnine, (0) pravo velikost radija 
preseka ter (10) presek v tlorisu in narisu. 

 



4. (10) Če je črka H velika 5 mm, kako velika naj bi bila črka a in kolikšen naj bi bil razmak med vrsticami. Skica! 

5. (10) Kaj veš o kotirnih mejah? Skice! 

6. (10) Skiciraj kocko v standardni izometrični projekciji in označi bistvene značilnosti projekcije.  

7. (10) Kaj ja padnica. Pojasni s skico.  

8. (10) Katere so tehnične značilnosti rasterskih zaslonov? 

9. (10) Naštej in pojasni dva glavna načina za računalniški zapis slik.  

10. (10) Kaj je značilno za slikarske programe?  

11.(10) Kaj so v CAD programih plasti?  

 



Predmet: 

OPISNA GEOMETRIJA 
Rok 

4.5.2004 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Letnik vaj Smer študija: Poskus: 

 
1. (15) Nariši krožni lok z radijem r=5 cm od točke T do premice p 
tako, da bo lok pravokoten na premico p.  

2. (25) Poišči manjkajoči ris točke T, ki leži na ravnini, ki je podana 
s premicama p in r.  

3. (40) Izračunaj površino kroga, ki nastane kot presek ravnine in 
krogle, ki ima središče v točki T in gre skozi točko A, ki leži na 
ravnini.Pomagaj si z bočnim risom. Nariši (15) toloris in naris 
krogle – prava velikost radia krogle?, (10) bočni ris krogle in 
ravnine, (5) presek krogle in ravnine, (0) pravo velikost radija 
preseka ter (10) presek v tlorisu in narisu. 

 



4. (10) Če je črka a  velika 5 mm, kako velika naj bi bila črka H in kolikšen naj bi bil razmak med vrsticami. Skica! S kako debelim 
pisalom bi morala biti narisana v ISO-B pisavi. 

5. (10) Kaj veš o kotirnih mejah? Skice! 

6. (10) Skiciraj kocko v standardni izometrični projekciji in označi bistvene značilnosti te projekcije.  

7. (10) Kaj je druga padnica. Pojasni s skico.  

8. (10) Katere so tehnične značilnosti rasterskih zaslonov? 

9. (10) Naštej in pojasni dva glavna načina za računalniški zapis slik. Kako se ta dva na]ina odražata pri napravah za risanje velikih 
risb?  

10. (10) Kaj je značilno za slikarske programe?  

11.(10) Kaj so v CAD programih plasti in zakaj jih uporabljmo?  

 



OPISNA GEOMETRIJA, navodila za stožesc 
 
odpreš autocad, izbereš cone(stožec) in te vpraša za center stožca->klikneš in podaš ali 
klikneš še radij stožca, zatem te vpraša še za višino stožca ki jo prav tako lahko vneseš ali 
klikneš. ko se ti nariše stožec izbereš še sphere(krogla) in te vpraša za radij kroga ki ga 
vneseš. potem premakneš tisto kroglo tako da bo krogla v stožcu. potem izbereš še samo ukaz 
subtract(odreži ali odštej) in klikneš na stožec->enter->klikneš kroglo in na koncu enter. za 
osenčenje pa nebi vedu kako misliš. 
 
 
Postopek za telebane: 
Autocad 
Draw ->Solids->Cone >določiš središče osnovne ploskve(kroga)(x,y,z).Določiš 
Radij(radius).Določiš višino(height)  
Draw->Solids->Sphere->center kroga, radij  
View ->3d Orbit -<premikaš tak, če si nisi prej nastavo, da bo pol lepo zgledalo.  
View->Shade->npr. FlatShade 
Modify->Solids Editing->Substract-prvo označiš nosilca.enter.drugi predmet je tisti, ki bo 
zgino. Od prvega izrežeš drugega!  
View->3D Orbit->premikaš, da bo lepo zgledalo  
 
Stožec ali krog lahko narišeš tudi tak, da samo napišeš v spodnje okno:cone oz. sphere  
 
Potrebno je še sprintat, najlažje je označit ta lik, ki si ga narisal.  
File->Export->ime.dwf. 
Greš v Word pa greš vstavljanje datoteke ali kaj takega in sprintaš ali pa direkt iz Autocada  
 
LP, Cyrone 



Predmet 

OPISNA GEOMETRIJA 
Rok 

11.5.1997 izredni 
Točke: Ocena: 

Priimek in ime 

 

Letnik vaj Smer študija: Poskus: 

 
1. (15) Nariši ločno prehodnico z radijem r=3cm med premicama p 
in r.  

2. (25) Ravnina je podana z drugo padnico p. Nariši slednici e1 in 
e2.  

3. (40) Kako daleč je točka T od premice P.    



 
4. (10) Kakšno oznako imajo slovenski standardi?   

5. (10) Kako je določena velikost formata A0.  

6. (10) Od česa je odvisna velikost znakov pri tehnični pisavi?  

7. (10) Skiciraj kocko v standardni dimetrični projekciji in označi bistvene značilnosti projekcije  

8. (10) Naštej in pojasni vrste projekcij glede na lego telesa glede na projekcijsko ravnino?  

9. (10) Definiraj, kaj je prirednica.  

10. (10) Naštej tehnične značilnosti rasterskih zaslonov.  

11.(10) Kaj je značIlno za ilustratorske programe?  

 



 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

A 
Rok 

20.4.1999 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 
IZREDNI ŠTUDIJ 

Poskus: 

 
1. (15) Nariši krog skozi točke A, B in C.  2. (15) Poišči prebodišči H in V premice p z Π1 in Π2.  

3. (40) na podani ravnini nariši tisto prvo padnico p, katere odsek 
v prvem kvadrantu je dolg natanko 3 cm. Pomagaj si z zvrnitvijo 
ravnine okrog e1 v Π2.   

 



 
4. (10) Naštej vsaj 4 kratice organizacij, ki izdajajo tehnične standarde.  

5. (10) Naštej in s skico pojasni vrste projekcij glede na osnovne elemente?  

6. (10) Definiraj in skico pojasni, kaj je koincidenčna ravnina?  

7. (10) Definiraj in skico pojasni , kaj je prirednica.  

8. (10) Naštej tehnične značilnosti rastrskih zaslonov.  

9. (10) Naštej in kratko opiši vrste programov za risanje.  

10. (10) Kaj pomeni kratica CAD?  

11.(10) Kako so lahko v računalnikih predstavljena telesa? Skica vseh treh načinov!  

 



Predmet: 

OPISNA GEOMETRIJA 
Skupina: 

A 
Rok 

3.5.2000 
Točke: 

              / 
Ocena: 

            / 
Priimek in ime: 

 

Vpisna številka: Letnik vaj Obkroži smer študija: 
IZREDNI ŠTUDIJ 

Poskus: 

 
1. (15) Nariši krog skozi točke A, B in C.  2. (15) Poišči prebodišči H in V premice p z Π1 in Π2.  

3. (40) na podani ravnini nariši tisto prvo padnico p, katere odsek 
v prvem kvadrantu je dolg natanko 3 cm. Pomagaj si z zvrnitvijo 
ravnine okrog e1 v Π2.   

 



 
4. (10) Naštej vsaj 4 kratice organizacij, ki izdajajo tehnične standarde.  

5. (10) Naštej in s skico pojasni vrste projekcij glede na osnovne elemente?  

6. (10) Definiraj in skico pojasni, kaj je koincidenčna ravnina?  

7. (10) Definiraj in skico pojasni , kaj je prirednica.  

8. (10) Naštej tehnične značilnosti rastrskih zaslonov.  

9. (10) Naštej in kratko opiši vrste programov za risanje.  

10. (10) Kaj pomeni kratica CAD?  

11.(10) Kako so lahko v računalnikih predstavljena telesa? Skica vseh treh načinov!  

 



Opisna geometrija 
1996/97 

KOLOKVIJ IZREDNI  28.03.
97

Priimek in 

ime: 

 Smer: GE-IZREDNI  

1. (5) Kako je dolo~ena oblika DIN formatov papirja. 

 

 

 

2. (10) Kako debeli naj bi bili srednja in tanka ~rta, ~e ima "zelo debela" debelino 

1mm.  

 

 

 

 

3. (20) Na{tejte vrste projekcij glede na osnovne elemente. Vsak tip pojasnite z 

majhno skico in na{tejte njegove invariante. 

 

 

 

 

 

 

 

 

 

 

 

 

4. Dolo~ite sredi{~i obeh krogov(5). Nari{ite lo~no prehodnico med obema krogoma, ki 

ima radij r=10cm(20). ^e tega ne znate, nari{tite tangento na oba kroga, po 

geometrijskem postopku(10). 

 

 

 

 

 

 

 

 

 

 

 

 



5. Skicirajte podano telo v poljubni frontalni aksonometriji (15). 

5

 



 

Opisna geometrija 
1996/97 

IZDENI [TUDIJ  6.6.96 

Priimek in 

ime: 

 Smer: GE-IZR  

 

1. (10T). Ravnina je podana s 
koinciden~no premico k in to~ko P. 

Poi{~i manjkajo~i ris to~ke R. 

 

 

 

 

 

 

 

 

 

2. (20T) Nari{i T" tako, da bo to~ka T od podane ravnine oddalejena za dva cm. 

Uporabi bo~ni ris. 

e1

e2

 
 

3. (15T). Skozi to~ko P ravnine e1 e2 nari{i prvo padnico. 

 



4. (15t) Definiraj in s skico pojasni ravnino koincidence in ravnino 

simetrije: 

 

 

 

 

 

 

 

 

5. (15t) Definiraj in s skico pojasni kaj je to prvo-projicirna ravnina 

 

 

 

 

 

 

 

 

 

6. (10t) Kaj pravi princip dualnosti - navedi en primer. 

 

 

 

 

 

 

 

 

 

7. (15t) Zakaj je pravokotnica na ravnino pravokotna na slednice ? 
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